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PC Programming

SECTION 1
GENERAL _ _
INFORMATION This chapter provides detailed information for programming using the
Electra Elite System Administration Terminal (SAT) software.
PC requirements:
@  Microsoft Windows 95/98 operating system
@  Available serial communication port on PC
@ MNP Class 4 or V.42 bis modem (if remote programming is required)
KTS hardware requirements:
@ MIFM-U10 KTU
SECTION 2
FEATURES OF PC
PROGRAMMING Some of the features of PC programming include:

Wizard — allows a user to select a feature using wizard. Wizard prompts
the user to program the necessary system data items associated with the
feature. When wizard is selected, a tabbed list of information is provided.

(For a detailed discussion of wizard, refer to Section 4 Wizard on page
3-2)

System Data Upload/Download — allows system data to be fransferred
from/to a personal computer to provide backup of data.
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SECTION 3
SOFTWARE
INSTALLATIOM 3.4 Instaliing Electra Elite System Administration Terminal
(SAT) Software
1. Insert the SAT CD ROM in the CD ROM drive.
2. Click the Windows 95/98 Start button,
3. Select Run.
4.  Enter a:\setup.exe and click OK.
(If installing from CD ROM, enter the letter of the CD ROM
drive.}
5 Follow the instructions on the PC installation prograim.
6. To start the SAT program:
«  Click the Win 95/98 start button.
-  Select PROGRAMS, NEC Electra Elite SAT.
- Click Elite System Administration Terminal (SAT).
+ Enter the password. The default password s
PASSWORD in uppercase letiers.
SECTION 4
WIZARD The wizard organizes system data assignments for programming

individual features. When the user selects wizard, the system provides a
tabbed list of information related to the selected feature.
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Wizard can be accessed by using the wizard bution from the
toolbar or by selecting Wizard from the File pulldown menu.
(Refer to Figure 3-1 Accessing Wizard.)

Figure 3-1 Accessing Wizard

When wizard is displayed, the technician can select any fealure
from the list or can begin entering letters of the feature name.
As the name is being entered, Quick Search finds the

matching letters and highlights the match.
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When a feature is selected, all system related data items for that feature
are presented in sequence. Enter the required values in the current tab
and click next to advance fo the next tab. Click back to go to previous tab.
In Figure 3-3 Sample Wizard, the Account Code Entry feature is selecled.

i

Figure 3-3 Sample Wizard
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SECTION 5
PROGRAMMING
SCREENS

Programming Manual
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Main Menu

When the SAT software program is launched, the Main Menu screen is
displayed first. This screen allows the user to access the options used to
program the Electra Elite system. Figure 3-4 Electra Elite System
Administration Terminal Software Screen Samples shows the menu and
describes the layout.

Pulidown Menu

Pulldown menus are available for each function involved in programming
the Electra Elite system. To access the data associated with the function,
click on the function name on the Main Menu. Some of the opfions on the
initial pulldown menu offer several selections. An arrow to the right of the
opticn name indicates additional selections are available. Refer to Figure
9.4 Electra Elte System Administration Terminal Scftware Screen
Samples for an example of a Pulldown Menu.

System Data Screen

When an option is selected from a pulldown menu, a screen is displayed
that allows the user to program data for the function selected. Figure 3-4
Electra Elite System Administration Terminal Software Screen Samples
shows an example of a System Data Screen. This screen indicates three
tabs. The tabs indicate system data items that are grouped together for
programming. The active tab group is indicated by a box around the tab
title. In the example, the displayed data is for the Terminal/System Wide
tab group. To access another tab group, press the tab or use the keyboard

shorlcut. Keyboard shortcuts are displayed at the bottom of the screen in
the Information Bar.
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Pulldown Manus

—— Help
Accesses help
information.
-
Toolizar
Status Bar Connection Status
As the selection Indicates whether or not
changes, the status the data path is connected
changes. to the Electra Elite
Pulldown Weriu System Data ltem
Soreean

Pulldown Menu . (e \ Tab Groups
Wake selections by clicking on i:fr:;r;z:;:mlﬁz:ﬂ:ﬁ“h: Information Bar The active Tak Greup is
an item. The associated screen option indicatas indicated by the darkened box
is displayed, . Keyboard surrounding the tab name.
Shortcut.

Figure 3-4 Electra Elite System Administration Terminal Software Screen Samples
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SECTION ©

TooLBAR Several icons are provided to allow the user to navigate the program. The
icons in the toolbar are explained in this section The availability of the
individual tools depends on the activity the user is performing. When the
icon appears shadowed, the tool is nol available. \When the icon is dark,
the fool is available. Refer to Figure 3-4 Electra Elte System
Administration Terminal Software Screen Samples for an example.

Creates a new customer configuration file.

'E@j Loads or opens an exisling customer configuration
ert file.

Saves the customer canfiguration file to the hard
disk, or floppy disk.

@ Accesses the Job Spacifications printing option.

Accesses the wizard for individual features.

Sets the defaults for aif items on the open tab.

Sets the defaults for the individual system data items
(on the screen the default is set for the item where
the cursor is blinking).

Allows data iterns to be copied between poris.

"‘]’ Allows values between two ports to be swapped.

Allows the user to undo the current edits and return
to the previous editing operation.
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Accesses Quick Search. Quick Search provides a
detailed list of system data items.

Returns to the previous tab group.

Advances to the next tab group.

Displays the help contents for the Electra Elite SAT
software program.

:‘ﬁj Scralls up displaying the previous page.
“”3 Scrolls down displaying the next page.
;j_l Advances to the first page.

\g% Advances to the last page.

’@ Displays the Connection dialog box.

RO
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SECTION 7
ELECTRA ELITE
PurLLpown NENUS
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This section explains each of the puldown menus that are available in
SAT software.

File

The File pulldown menu provides options for basic file management.

Figure 3-5 File Menu

New
Creates a new configuration file.

Open
Loads an existing configuration.

Save
Saves the configuration file. This option is only available when a
configuration file is open.

Save As

Saves a configuration file using a new name. This option is only available
when a configuration file is open.
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Close
Closes the current configuration file. This option is only available when a

configuration file is open.

Wizard

Accesses the Wizard. Wizard is available for every feature offered in the
Electra Elite system. Wizard provides all of the information necessary io
program a feature. Al of the system data items necessary for
programming the feature are grouped together. The user can press the
appropriate tabs to access system data and make the necessary changes.

This option is only available when a configuration file is open.

Change Password
Allows the user to change the SAT password.

Print
Provides two print options: Job Specifications and Designation Labels
(requires a standard inkjet or laser printer).

When Job Specifications is selected, 2 menu is displayed with three print
options far the Job Specifications: print a family (group) such as
system-wide, trunk group, or tenant, print a range of Memory Blocks, or
print an individual Memory Block.

When Designation Labels is selected, SAT automatically opens the DESI
for Windows label printing application. The current telephone information
is automatically exported to DESI. Labels can then be configured and
printed for the telephones. This requires the NEC LASER Labels for
printing on InkJet or Laser printers.

iw  For the Designation Labels option to be enabled, the DES| for Windows
application must be installed on your computer. Installation is usually done
during the installation of SAT.

Print Setup
Allows access to the printer setup screen. This allows the printer
configuration fo be modified.

Recent File

Displays the last two files that were opened. These are listed as 1 and 2.
The user can select either file to open. This option is only available when
New or Open is selected.

Exit

Exits the programming software. If changes have not been saved, the
technician is prompted to save the changes before the program shuts
down.

PC Programming
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Figure 3-6 Edit Menu

Undo
Allows the user to undo current edits and return to the previous editing

operation.

Copy
Brings up the copy screen. This allows port information to be copied from

one port to another,

Swap
Allows values between two ports to be swapped.

Set Default
Defaults to the current field where the cursor is positioned.

Set Default All
Allows the user to set all values to default on the open tab.

Quick Search

Allows the user ta search the Memory Blocks by Memory Block Number,
Memory Block Name, or Tab Name. After the search method is specified,
a list is provided. The user can scroll through the list and click on the
desired Memory Block. System data can then be modified as necessary.
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The Basic pulldown menu allows access to basic programming items.

= Some menu items may be disabled if the appropriate hardwars is not

assigned, or a dependent data item is not set.

System Configuration
This option allows the technician to configure the customer system by
indicating the cards that are inslalled for each slot in the KSU.

Terminals
This option alicws the technician to assign the terminals to the system.

Several selections are available with this option.

System Wide
Station Base
Multiline
Single Line
DSSMBLF

Doorphonas

Figure 3-7 Basic Menu

e T
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CO/PBX Trunks
This option allows technicians to program system data related to trunk

assignments,

Three seleciions are available with this option:

@ System Wide
@ Trunk Base
i Timers

Intercom
This option allows the technician to program system data related to

intercom assignments

DISA
This option allows the technician to assign codes for Direct Inward System
Access (DISA)

Paging
This option allows data related to paging assignments fo be programmed.

Access Codes
This option allows the technician to enler Access Codes. Where
appropriate, Access Codes are set to default system values.

Speed Dialing
This option allows data related to system and station speed dialing to be
programmed.

System Timers
This option allows system-wide timers to be assigned.

Tenants
This option allows data related to tenant assignments to be programmed.

Call Arrival Keys
This option allows Call Arrival block assignments to be programmed.

Forced Account Codes

This option allows the technician to program the account code length and
to assign account codes.

Programming Manual 3-13
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Application

The Application puildown menu allows access fo system data ilems
relating to advanced system applications.

e R
" R E ey oL R il -

Figure 3-8 Application Menu

Code Restriction
This option allows code restriction assignments to be programmed.

SMDR
This option allows data related to Station Message Detail Recording to be

programmed.
Tandem Transfer

This option allows the assignment of data related to the routing of a call
through the system.
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TLIHD
This aption allows data related to Tie Lines and Direct Inward Dialing to be

programmed.

Three selections are available with this option:

@ Trunk Base
1 Metworking
ey Timers
DTuT

This option allows data related to the master clock and T1 signaling
formats to be programmed.

ACD/UCD o
This option allows the technician to set up Automatic Call Distribution and

Uniform Calls Distribution Hunt groups.

Voice Mail
This option allows data related to the intemal voice mail to be

programmed.

VRS/Delay Announcement
This option allows data to be assigned for the VRS ETU (e.g., greetings).

Automated Attendant
This option allows the technician to program the data related fo
messaging.

Caller D

This option allows Caller |1D displays to be programmed and display
assignments fo be assigned per port.

ISDN/BRT

This option allows the assignment of information related to ISDN/ERT
trunks such as SPID assignments, IDSN telephone numbers, and
BRT/DTMF durafion.

3-15
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Users

The Users pulldown menu allows access to system data items relaled to
speed dialing.

Figure 3-8 User Menu

Speed Dialing
This option allows the technician to program Speed Dial memories for
each Multiline Terminal in the Electra Elite system.

T
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Communications

The Communicalions pulldown menu allows access fo system data items
relating to direct and remole connhections to the Electra Elite system.

Figure 3-10 Communications Menu

Connect
This option allows the technician to connect to the Electra Elite system.

Connection can be Direct or Remote. Direct connection is when the SAT
PC is directly connecled to the Electra Elite system. With Remote
connection, the SAT PC uses a modem to dial into ancther external
remote modem that is connected to the Electra Elite system. If the
MIFM-U10 KTU is equipped with a socket modem (modem kit part no.
7506820), then the external remote modem is not needed. For Direct
connection to the KTS, connect the serial cable included with the SAT
from a free serial port on the SAT PC to the COM 1 port on the KTS.
Select Communications, Connect. Select the Setup button fo choose PC
COM port. Choose Direct Connection and click the Connect button. For
Remote connection to the KTS, choose Modem Connection and select the
Dial button. For the Modem connection, the PC must have an MNP Class
4 modem. This connection allows the user to program a KTS located at a
remote location.
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In either case, after a successful connection is established with the KTS,
you are ready to upload and download data to and from the KTS.

Disconnect
This option allows the technician to disconnect from the Electra Elite
system.

Upload
This option allows the technician to upload programming changes and
configurations to the KTS.

Download
This option allows the technician to download the current Electra Elite

configuration.

Verify
This option allows the technician to compare the configuration
programmed in the KT8 with that of the PC.

First Initialization
This option reintializes the system to the factory-set defaults.

All active calls on the system are dropped.

Second Initialization
This option reboots the system without resetting the programmed defaults
(i.e., all programming is retained).

Setup
This option allows the technician to set up the system to provide
communication. Four options are available for this selection.

@ PC Serial Port — serial port of the PC that is connected to the KTS.

@ Access Password — the password programmed in Memory Block
1-8-17 on the KTS.

@ Site Name — the name of the site that is being programmed.

@  Setup & Initialize — the KTS port settings/configurations.
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Help

The Help pulldown menu allows access to online help.

Wiz Hep
g
Hep fopss
bty M ried
B rmrn

Figure 3-11 Help Menu

Using Help
This option provides access lo the help topics window that describes how

to use the help function.

Contents
This option provides access to the help topics that are available for the
Flectra Elite System Administration Terminal system.

Help Topics
This option provides a list of help topics. The user can bookmark topics
that they may want to refer to again.

Show MB Numbers
When the cursor is positioned over a data field, the memory block number
i5 displayed above the cursor.

About
This option provides information about the System Administration

Terminal software (SAT).
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